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Micro Focus Academic Program 7.0 Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Overview
The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.
COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.
The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.
This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.
Welcome! We’re excited to have you join our growing academic community.
Product Description
The Micro Focus Academic Program Edition package comprises the following products:
•

Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.
Variants of Visual COBOL include:

•

• Visual COBOL for Visual Studio 2017 or Visual Studio 2019
• Visual COBOL for Eclipse (Windows)
Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:
•
•

Enterprise Developer for Visual Studio 2017 or Visual Studio 2019
Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:
•
•
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You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.
An authorization code for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.
For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.
Reporting Issues
•

For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any updates to the documentation which might have been uploaded.

Upgrading from earlier Micro Focus products
This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.
A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.
To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.
If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.
If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.

What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:
•
•

Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.
Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.
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•

•

Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.
Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 7.0 release.
Enhancements are available in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Micro Focus COBOL Extension for Visual Studio Code on page 6
.NET Core Support
Application Workflow Manager
Assembler Support
CICS Support
COBOL Language Enhancements
Code Analysis
Code Set Support
Compiler Directives
Containers Support
Database Access - HCOSS Manage Connections Tool
Database Access - MBDT Utilities
Database Access - OpenESQL
Data File Tools
Eclipse Integration
Enterprise Server
Enterprise Server Common Web Administration
Enterprise Server for .NET
Enterprise Server Security
IMS Support
JCL Support
Library Routines
Licensing Technologies
Mainframe Access
Micro Focus Database File Handler
Micro Focus Unit Testing Framework
Micro Focus Rumba
PL/I Support
Visual Studio Integration

Micro Focus COBOL Extension for Visual Studio Code
Back to Top
The new Micro Focus COBOL extension for Visual Studio Code is available on the Microsoft Visual Studio
Marketplace. This provides edit, compile and debug support for Visual COBOL and Enterprise Developer
users in Visual Studio Code.
Note: The new Micro Focus COBOL extension is not included with the Visual COBOL or the
Enterprise Developer installers.

.NET Core Support
Back to Top
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Support has been added for creating, building and running .NET Core projects using the dotnet
command. This new support is in addition to the ability to work with .NET Core projects in the Visual Studio
IDE.
This functionality is available in the following products:
•
•
•
•

Visual COBOL for Eclipse
Visual COBOL for Visual Studio
Enterprise Developer for Eclipse
Enterprise Developer for Visual Studio

Application Workflow Manager
Back to Top
Improvements have been made in the following areas:
•

Modelling support for tool process logic under an action:
•

•

You can now model loops and conditional execution of tools under an action, making the modeling of
complex tool logic under an action easier and more transparent.
Icon support:
•

•

Icons can be specified to consist of several layers which, for example, enables you to model icons
with decorators. The decorators can be displayed depending on conditions.
• Additional icons have been added to AWM.
• You can now specify and use your own icons.
• You can now specify icons for filter definitions.
Filter definitions view:
•
•

•

You can now export and import filter definitions to and from another workspace.
The filter definition view's structure has been changed to a tree design enabling you to group
corresponding filters.
"Micro Focus z/Server" connection type:
•

•

Now supports drag & drop of a data set from the connection to an enterprise server instance's
catalog entry.
• You can now compress a z/OS PDS data set.
New Micro Focus DevHub connection type function package:
•

Provides a tool to send commands to a Micro Focus DevHub connection and receive the output
returned by the command so that it can be processed by other tools.

Assembler Support
Back to Top
This release includes the following enhancements:
•

Support for Assembler data table generation on UNIX and Linux - a new command-line executable,
MFMODGEN, is available on these operating systems to generate an Assembler data table (.MOD file)
from an Assembler source file.
This feature is the only Assembler functionality currently supported on UNIX systems. The rest of the
Micro Focus Assembler functionality is supported for 32-bit Windows only.

CICS Support
Back to Top

Micro Focus Academic Program 7.0 - Release Notes

|7

CICS support in development has the following new features:
•

A 64-bit BMS Compiler on Windows and UNIX - the command-line utility, MFBMSCL, is now available in
64-bit format on Windows as part of Visual COBOL and on UNIX as part of .
On Windows, Eclipse now uses the 64-bit BMS Compiler by default.
The availability of the compiler on UNIX means that in remote development scenarios using Eclipse,
BMS files are compiled directly on the UNIX machine. It is no longer necessary to copy the BMS files to
your local Windows machine to compile them. There is no longer a requirement to only use SAMBA
connections if your remote projects include BMS files.

CICS support in deployment has the following new features:
CICS support inside Visual Studio:
•

The support for viewing CICS (PCT, PPT and FCT) resources inside Visual Studio is now a full support
and no longer a Technical Preview.

COBOL Language
Back to Top
The following enhancements have been made to the Micro Focus COBOL language:
•

•
•

.NET COBOL and JVM COBOL data type to hold strings of utf-8 characters - support is now
available in .NET COBOL and JVM COBOL for the PIC U data type. This was already available for
native COBOL, to support its introduction by IBM in Enterprise COBOL version 6.3.
The DYNAMIC LENGTH clause, which enables a data item to vary in length at run time, is supported.
Again, this is in response to its introduction by IBM in Enterprise COBOL version 6.3.
The following date-format-checking intrinsic functions have been added: TEST-DATE-YYYYMMDD and
TEST-DAY-YYYYDDD.

Code Analysis
Back to Top
This release includes the following enhancements:
•

Get Direct References command - you can use this command to see if changing a file will affect the
other files in your project as well as the files in the whole application. In Visual Studio, you can access
this command from the context menu for COBOL files in Solution Explorer or from the Analysis Server
window. In Eclipse, you can access this from the context menu or from the Application Server Explorer.

•
•

The Data Flow Analysis in Visual Studio is now available in both a tree and a graph view.
The Code Analysis functionality is now available for the Procedural Multi-Output Project (.NET
Framework) type.

•

Import points of interest - the Code Analysis view in Eclipse now includes a button, Import points of
interest.

Code Set Support
Back to Top
The following enhancements have been made to the integrated code set translation support:
•

Arabic support for Enterprise Server applications is available.
If you are building Arabic support into Enterprise Server applications, your terminal emulator must
support the Arabic EBCDIC 420 code page.
Support is added by building your applications and configuring your enterprise server regions with the
MFCODESET variable set to the supported country code (0420). Your product's in-built code set
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translation utility performs translations between the ASCII 1256 Arabic code page on your enterprise
server region, and a terminal emulator that supports the Arabic EBCDIC 420 code page (for example,
IBM's Personal Communications emulator).
There are some considerations when working with a bi-directional language such as Arabic.

Compiler Directives
Back to Top
The following Compiler directives are new in this release:
•
•
•

PANVALET-INCLUDES-IN-COMMENTS - This directive controls whether ++INCLUDE statements in
comments are actioned or not.
EXECSQL-FLAG - This directive defines whether syntax reporting should emulate that of the DB2
preprocessor, the DB2 coprocessor, or to allow all syntax variations of both.
RM-FILE-ERRORS - This directive generates run-time system errors for certain file conditions, even
when a FILE STATUS clause is present; this is to emulate RM/COBOL behavior.

The following Compiler directive option has been deprecated:
•

ILCLR(2) - this is as a result of deprecating support for versions 3.0 and 3.5 of the .NET Framework.
Applications that have this option set will produce an E level message when compiled in this release of
Visual COBOL.

Containers Support
Back to Top
Support for containers in Visual Studio has the following enhancements:
•
•

You can now add a Dockerfile to native Micro Focus Unit Testing projects in Visual Studio and run the
tests in a container.
Projects with Docker support now include an additional Containers property page. From it you can:
•

•

Specify any build, debug and run arguments for the image that will override the arguments specified
in the project's dockerfile.
• See all command-line arguments that will be applied when you build the image.
• See the arguments that will apply when you run the container, or debug an application running in a
container.
The Add COBOL Docker Support dialog box now shows all available images, and supports images
provided with a Patch Update release of this product suite.
The versions of the Runtime Image and the Built Tools Image must match therefore the dialog box
only shows the Built Tools Image that match the one for the runtime. For example, if you use a Patch
Update 1 Build Tools image, the dialog box only shows the relevant Patch Update 1 Runtime image.
The dialog box shows only the images that match the major release version (or a Patch Update of it) of
your installed product. They must target the same platform (x64 or x86) as well. If you want to specify
images from different major product versions, you need to edit the Dockerfile manually.

Database Access - HCOSS Manage Connections Tool
Back to Top
This release includes:
•

Enhanced usability features around connection error diagnosis and SQL Server connection/installed
ODBC driver selections.

Micro Focus Academic Program 7.0 - Release Notes
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Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require further
clarification.

Database Access - MBDT Utilities
Back to Top
This release introduces:
•

The SQLTUL utility, which is equivalent to the z/OS DB2 DSNTIAUL program.
Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

Database Access - OpenESQL
Back to Top
This release provides the following enhancement:
•

New OpenESQL TRACELEVEL=5 option - native OpenESQL applications can now trace ODBC calls to
the database vendor’s ODBC driver, recording the start and stop times of each call’s execution.
OpenESQL tracing can now provide more detail on where an SQL application is spending execution
time, in the OpenESQL layer or the underlying ODBC driver layer.

Data File Tools
Back to Top
This release includes the following enhancements in the Data File Editor:
•

•
•
•

•

•

New Data Explorer for working with data sets - a new Data Explorer enables you to connect to either
an ESCWA service or directly to an enterprise server region to access a catalog when working with
data sets in the editor.
Multiple record selection- you can select multiple records and, where appropriate, can perform certain
actions on more than one record at once.
Cut, copy, and paste functionality - traditional cut, copy, and paste functionality (including the
standard Ctrl+X, Ctrl+C, and Ctrl+V shortcuts) is now available throughout the editor.
New filter creation - a new process for creating filters has been introduced. A filter consists of one or
more sets of conditions, and the resulting filter can include or exclude those records selected. The
previous filter process is still available, but has been marked as deprecated.
Remote filtering - functionality has gone into Fileshare Server which allows filtering to occur server
side when opening data sets on remote enterprise server regions. The filter process results in only
those filtered records being downloaded to the data file editor client.
Find/replace functionality - you can search records in a data file to identify specific strings, and then if
required, replace them.

Eclipse Integration
Back to Top
This release includes enhancements in the following areas:
•

Supported Eclipse versions - this release supports Eclipse 4.16 (2020-06), which is shipped and
installed with Visual COBOL.
Versions of Eclipse prior to this one are not supported.

10
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•

•

•

Micro Focus Search - the search has been enhanced to filter results on the build action: in the Limit
To section, select Files configured for compilation to only include files in the search results that have
a build action set to Compile. The search results also include a new column, Build Action, that shows
the current action for each file.
Formatting profiles - the formatting preferences for your COBOL code are now stored in profiles. You
can have many profiles per workspace, allowing you to easily switch between different sets of formatting
for different projects. The profiles can also be shared between local workspaces and to other users,
allowing developers to format code consistently throughout their team.
The following new preferences have been added:
•
•

Force native line endings when pasting with Ctrl + Shift + V, available from Micro Focus >
COBOL > Editor: this option produces line endings native to the local operating system.
Show Compiler directive summary in editor, available from Micro Focus > COBOL > Editor >
Compiler Directives summary: this option shows a summary of the Compiler directives in effect, in
the editor.

Enterprise Server
Back to Top
This release includes the following enhancements:
•

•

•

Multiple Network Interface support - there is improved support for multiple network interfaces in some
components, including better awareness of network interfaces and control over networking. This is a
partial implementation and will be enhanced in future releases.
Extended IPv6 support - support is available in Micro Focus Directory Server (MFDS) and in the Micro
Focus Communications Server (MFCS) listener for multiple IPv6 addresses.
In release 6.0, you could only configure MFDS and MFCS listeners to listen on a single IPv6 address. In
release 7.0, by default, MFDS and MFCS now listen on all configured IPv4 and IPv6 addresses, and
can also be configured to listen on a combination of specific addresses.
HTTP improvements:
•
•

•
•
•

•

Additional security measures for HTTP, such as security-related headers.
Chunking support for large HTTP messages makes it possible to retrieve very large files from
Enterprise Server regions.
• Enhancements to CICS Web Interface and CICS Web Services.
Application Diagnostic Reporting for Enterprise Server - Application diagnostic reporting collects and
packages a number of reports, trace, and log files into a single report file.
Enterprise Server now supports automatic reconnection to the standby Queue manager in an MultiInstance Queue Manager.
The casmgr process has been optimized to improve the use of initiators when dispatching jobs across a
PAC. In addition, improvements have been made to the way it manages the queue of jobs waiting to be
dispatched.
Information has been added describing the best practice and the recommended approach you should
adopt when performing a Patch Update to your PAC environment.

Enterprise Server Common Web Administration
(ESCWA)
Back to Top
This release offers the following improvements:
•

MFDS User Interface functionality replacement - ESCWA now replaces the MFDS inside the IDE as the
engine that provides access to and management of regions. ESCWA provides all the functionality that
was previously available from MFDS. This release includes the following enhancements:

Micro Focus Academic Program 7.0 - Release Notes
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•

• Delete all regions.
• Session list.
• Renew listening addresses.
ESMAC User Interface functionality replacement - the following ESMAC features have been
implemented in ESCWA:
•
•
•

•

Resource Filtering.
Millisecond support.
Control the scope for all changes to timeouts, trace flags, and memory strategy when applied to
regions in a PAC.
• Enable Application Diagnostic reporting.
• Submission of local jobs from the JES Control page when CASRDO44_NEWSUB=OFF has been
specified.
• View and reply to pending ACCEPT FROM CONSOLE statements.
• The messages after a JCL job has been submitted are now correctly JSON formatted. This page
now works in ESCWA when MFJUXIT is enabled.
Import, export, and copy regions - you can now use the UI to export and import regions in various
formats, including use JSON. You can:
•
•

•

Copy regions between Directory Servers
Import and export regions in JSON, XML or in the .dat legacy format. The legacy format can be
converted to a modern format.
Mainframe Access (MFA) administration - ESCWA provides a modern Web UI and does not require you
to use a separate terminal application. Features include:

•
•
•
•
•
•
•
•
•

Log in or off from MFA.
Change your MFA password.
View MFA server tasks.
Retrieve the XDBOUT log (Web UI).
Retrieve the JES spool files by DD Name (API).
Set the MFA and JES tracing level.
View the active MFA users.
Invalidate active user sessions.
View mainframe/MFA statistics.

•

The MFA API library has been exposed to enable you to test and use the requests that are provided.
CICS resource support - the following resources are supported:

•

• Resource Name List (RNL) CICS resource.
• Thresholds CICS resource.
• Extended Architecture Table (XAT) CICS resource.
Scale-Out and PAC administration - you can now:
•
•

Monitor Redis Sentinel and Cluster instances when used for Scale-Out Repositories.
Specify that all changes to timeouts, trace flags, and memory strategy can be applied to one of three
options:
Only the local region.
All members of a PAC except the regions where local changes have been made.
All members of a PAC.

•
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You can configure this in ESCWA with the Apply Scope field on the ES CONTROL page.
Alternatively, you can use the casutl utility with the /w option.
Multi-Network Interface Card support - ESCWA now enables you to configure Communications Servers
and Listeners to listen on multiple IPv4 and IPv6 addresses. Previously, they were limited to listen on
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either all IPv4 addresses, or a single IPv4 or IPv6 address. Now a combination of any of the following
can be used:

•

• One or more specific IPv4 addresses.
• One or more specific IPv6 addresses.
• All IPv4 addresses.
• All IPv6 addresses.
A new filter field resFilter has been added to the following ESCWA and ESMAC resource listing
modules:
Every resource in By Type
Every resource in By Start L
Resource lists under Groups
Every active resource type except Locks
This parameter will filter the list of resources displayed by ESCWA and ESMAC. In addition, a new
environment variable ES_RDO_MAX_RESOURCES has been added that enables you to specify a limit
to the number of records displayed. For JSON requests, the list being truncated is indicated by the
addition of the JSON property "truncated": true.

Enterprise Server for .NET
Back to Top
This release includes the following enhancements:
•
•
•

CICS time calculations - ABSTIME, EIBDATE, EIBTIME, FORMAT TIME, and CONVERT TIME have
been improved.
CICS condition handling has been improved.
A new option, console message maximum, enables you to specify how many console messages are
retained. Previously, this value was fixed at 10000.

Enterprise Server Security
Back to Top
This release includes the following enhancements:
•

•

MLDAP ESM caching - the MLDAP ESM Module now implements LDAP search-result caching. This is
controlled by the existing Security Manager cache settings, so that many installations will have this
activated automatically. See the product Help for details.
Vault Hashicorp support - support is available for using a Hashicorp KV2 vault server as a local or
remote vault.

IMS Support
Back to Top
This release includes the following enhancements:
•

An IMS Automated Operator Interface (AOI) - allows an application program to send IMS commands to,
and receive responses from IMS Transaction Manager using the DL/I CMD and CGMS functions. This
support includes:
•
•
•

Visual COBOL and Enterprise Server support IMS DL/I functions CMD and GCMD across all
language interfaces. These functions are used to send IMS commands and receive responses.
Commands can be sent from applications compiled either ASCII or EBCDIC.
Commands sent using AOI are limited to those supported in Visual COBOL and Enterprise Server.

Micro Focus Academic Program 7.0 - Release Notes
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•
•

•

•

You can install an exit program that enables programming support for commands not directly
supported by Visual COBOL and Enterprise Server.
The IMSAO.CBL and IMSAO.JCL sample files, located in %PUBLIC%\Documents\Micro Focus
\Visual COBOL\Samples\Mainframe\IMS\Classic\Examples, are provided to demonstrate
the use of AOI.
The AOEXIT.CBL program, located in the same place as the other AOI sample files, is an example
of an installed exit routine for processing of AOI commands. Instructions for this interface are
described in the program source.

The IMS editor in Visual Studio now offers Renumber and Unnumber commands for PSB files.

JCL Support
Back to Top
This release includes the following enhancement:
•

New Spool and Catalog windows in Visual Studio - the Spool and Catalog windows have been updated
and are now based on ESCWA functionality. You can view and modify the details of a job and a catalog,
create new items, all in one page of the window.

Library Routines
Back to Top
The following library routines are new:
•

CBL_GET_ERROR_INFO - enables error processing routines to establish the location of the error that
occurred to cause the error processing routine to execute. This is available on a restricted range of
platforms.

Licensing
Back to Top
AutoPass licensing technology
In this release, Micro Focus brings in the power of the in-house Micro Focus AutoPass licensing technology
alongside Sentinel RMS. AutoPass has the following additional benefits compared to Sentinel RMS:
•
•

Usage logging which enables you to monitor the product usage. You need to install the AutoPass
License Server in order to do this.
Ongoing support for all platforms that this product is available for.

Features include:
•
•
•

•
•

14

Installing this release installs both the AutoPass Daemon and the Sentinel RMS License Manager. Both
of them are available in the Micro Focus License Administration tool.
You can have both AutoPass and Sentinel RMS licenses installed on the same machine. Optionally, you
can switch off the licensing technology you do not use.
If you are an existing user of a Visual COBOL or an Enterprise Developer product, you only need an
AutoPass license if you want to utilize usage logging or if you want to use your product on a platform on
which Sentinel RMS is not supported.
If you are a new user of the Micro Focus COBOL products, you will normally be issued an AutoPass
license.
Micro Focus will continue to provide Sentinel RMS in future releases of this product.
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Installing licenses at the command line
On Windows, Micro Focus License Administration is now also available as a command-line utility.
For more about AutoPass and usage logging, and about Micro Focus License Administration, see
Managing Licenses in your product Help.

Mainframe Access (MFA)
Back to Top
This release includes the following enhancements:
•

•
•

•
•

Improved file download and upload speeds - offers over seven times faster speeds for compressed files
larger than 64K, and almost four times faster speeds for uncompressed files over 64K. This requires
that you update both the Mainframe Access client and server, if you are using an older version of them.
Endevor transaction performance improvements - transactions with Endevor have been improved and
are now around two times faster.
Support for MFDAS load and unload - load and unload-specific load library members are now available
from the MFDAS command line. This enables you to interact remotely with Load libraries from the
MFDAS command line.
SCLM export protection - you can now configure the MFA components to respect the SCLM managed
flags. In this way, you can prevent outside source control changes to your managed datasets.
Drag and drop from the MVS Explorer to Catalog Explorer in Eclipse - you can now drag files to the ES
Catalog from MVS Explorer instead of having to use the Mainframe Explorer connection.

The Micro Focus Database File Handler
Back to Top
This release includes the following enhancements to the Micro Focus Database File Handler:
•

•
•

•

Oracle support: support has been added for use with Oracle databases (version 19c and later).
Support is mostly equivalent to that of the existing databases, except that ODBC connectivity is not
supported; connections must be made directly with the databases, using Oracle's OCI interface.
The dbfhview command line utility: a command line utility that generates database views from your
Data File Editor structure files. These views allow you to view your data once it's stored in a datastore.
The mfdbcatc command line utility: a command line utility that helps you to relocate a disk-based
catalog to a database. It can scan the current catalog, then generate a deployable response file that
attempts to maintain the current structure of the catalog.
COBOL Run-Time System support for datastores: Library routines and variables that typically deal
with files and folders on disk are now capable of also handling the SQL URLs required to reference file
and folders in a datastore.

The Micro Focus Unit Testing Framework
Back to Top
The following enhancements have been made to the Micro Focus Unit Testing Framework:
•

•

The MFUPP preprocessor has been introduced to provide a seam between your program and a unit
test. This seam lets you access the internals of a program under test, allowing you to create granular
unit tests from paragraphs or sections. The MFUPP preprocessor also provides the ability to mock
programs or stub programs out to create a unit test.
In Eclipse, remote unit test projects for native COBOL can now be stored and run from .

Micro Focus Academic Program 7.0 - Release Notes

| 15

Micro Focus Rumba
Back to Top
Support for Micro Focus Rumba inside Eclipse has the following enhancements:
•

•
•

Multiple views for embedded Rumba connections - it is now possible to have multiple Rumba Mainframe
Display views opened in the IDE, each having a different connection. You can enable multiple views
from the TN3270 preferences for the IDE.
Connections to a server are now secured using SSL/TLS.
Import and export connection details - it is now possible to export and import connection details and
share them between client machines.

PL/I Support
Back to Top
Enhancements are available in the following areas:
PL/I compiler compatibility:
•
•
•
•

New statements supported - DEFINE STRUCTURE, LOCATE.
Improved compatibility for the DEFAULT RANGE statement.
New built-in functions - AUTOMATIC, ENTRYADDR built-in function and pseudovariable, HEXDECODE,
INLIST, ISLL, ISRL, REPLACE, and TIMESTAMP.
Support for the DIMACROSS attribute and for the PARM attribute on a declaration.

PL/I compiler functionality:
•
•
•
•
•
•

You now receive warnings when redundant WHEN clauses appear in a SELECT statement.
Improved compiler listings to show more attributes for parameters.
The editor in Eclipse is now sensitive to EXEC SQL Host variables, references, and modifications.
The PL/I Compiler and preprocessors are now used by default for background parsing in Eclipse.
In Eclipse, you can now format the code inside a PL/I program or only format selected sections.
The PL/I error messages in the product Help are now in sync with the messages shown in the product.

PL/I debugger:
•

Much larger call stacks are now supported.

•

Debug profiles in Visual Studio - PL/I projects now support debug profiles, a feature of Visual Studio,
where a debug profile stores a set of properties which specify how to start debugging the application.
You can create and manage multiple debug profiles available on the Debug tab in the project's
properties.

PL/I EXEC Preprocessor:
•
•

Provides information about host variable references/modifications for the background parsing.
Support for DB2 style comments in EXEC SQL Statements.

PL/I Macro Preprocessor:
•
•

The SCAN option of the ANSWER statement is now supported.
Improved compatibility of COMPILEDATE and COMPILETIME built-in functions.

PL/I Run-Time System:
•
•
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The behavior of PL/I ON FINISH now matches IBM's behavior.
Improved compatibility for the JSONPUTVALUE built-in function - it now supports multi-dimensional
arrays within structures.
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•
•
•
•

Improved compatibility for the XMLCHAR built-in function.
PLIDUMP now checks the allocated memory chains for corruptions.
PLIDUMP can now display much larger automatic variables and parameters without consuming excess
memory and CPU resources.
Support for the L format PUT EDIT directed I-O.

Visual Studio Integration
Back to Top
This release includes enhancements in the following areas:
Editor:
•

•
•

Code cleanup - Visual Studio now supports a variety of code cleanup options for COBOL which you
can apply during formatting. These enable you to update any existing code, or enforce rules for new
code for specific keywords or operators.
EditorConfig file support - you can now create .editorconfig files with the code style settings in
the IDE, and share the file within your organization to ensure consistency of the code.
The Force uppercase command is now available for Assembler, BMS, and JCL files opened in Visual
Studio.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Application Workflow Manager
Assembler Support
Common Communications Interface
Communications Server
Compiler
Data Tools
Eclipse IDE
Enterprise Server
File Handling
Header-to-COPY Utility
Interface Mapping Toolkit
JCL Support
Mainframe Access
Micro Focus Batch Scheduler Integration
PL/I Support
REXX Support
Run-time System
SQL: Mainframe Batch Database Tools
SQL: OpenESQL

Application Workflow Manager
Back to the list
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•

The checkout tool has been extend with the new input parameter "Resource Depth" which indicates
how the checkout will be performed. Allowed values are:
5 Infinite (all files and folders are check out recursively).
4 Immediate (direct files and empty folders are check out).
3 File (only files are check out).
2 Empty (the selected resource is check out without content).
See Checkout in your product Help for more information.
00486821 (71096)

•

The ChangeMan attachment model now enables you to define job cards by a context menu action on
the application level. The action "Set Job Cards" is provided under the group "Quick ChangeMan
Access". If job cards are set, they are used in ChangeMan actions which submit a job, for example, the
build action.

•

(10698)
There are now new import/export functions available in the filter definitions view. The import/export
functions are available as context menu and tool bar actions.

•

00371941 (13136)
The Endevor attachment model now displays an error message when an attempt is made to open a
nonexistent element for editing.
3221338 (12418)

Assembler Support
Back to the list
•

Define Constant character items are now filled with EBCDIC spaces when you specify a null character
string to match the IBM HLASM behaviour. For example:
ALAB 40C'' or ALAB CL40''
DC C'' instructions are now IBM HLASM compatible. This should not affect any customer but some may
notice cobol like DEFAULTBYTE(X'40') values in their DC C... data items now. Such a change should be
innocuous for existing customer programs.
3237050 (12504)

Common Communications Interface
Back to the list
•

The default TLS Security Level has been increased from 0 to 1. This change will not affect you if you
have specified your own security options.If you rely upon the default TLS security options you might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See Security Levels and Specifying a Server Protocol and Cipher Suite Preference in your product Help
for more information on the change to Security Level 1.
(8453)

Communications Server
Back to the list
•

The functionality of GIVE and TAKESOCKET have been modified to make them more similar to the
documented IBM behavior:
•
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If a caller issues a GIVESOCKET specifying a subtask, then only a caller will be allowed to take the
socket if they specify the same subtask.
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•

A caller can supply an empty (spaces) subtask on the client parameter to indicate that anyone can
take the socket.In order to achieve this, a dummy client is inserted during a GIVESOCKET call if the
subtask name does not match an existing client entry.

00422057 (59129)
Compiler
Back to the list
•

•

Programs with file records greater than the documented limit of 62KB will now generate an error that
they previously did not (COBCH0649) - although being an E level message, the program can still be
executed and will work if it did so previously.
3227892 (12447)
Two of the available Ant parameters for compiling COBOL programs have been renamed as follows
(functionality remains the same):
•
•

forceCompile becomes mf.forceCompile
threadCount becomes mf.buildThreadCount

3230709 (12665)
Data Tools
Back to the list
•

•

•

The editor now automatically selects the first record in comparison when first loaded. The Editor will
automatically select first record in comparison when first loaded
3212848 (11362)
Data File Tools now provides the Data Explorer, which is a catalog view that can connect to either
ESMAC or ESCWA. When connecting to ESCWA, it enables you to open multiple data sets.
(70242)
The scrolling speed for formatted records has been increased.
00366018 (11378)

Eclipse IDE
Back to the list
•

•

In Server Explorer, the "associate with project" option is not longer available for remote servers. Remote
servers are defined as any belonging to a remote directory server or remote ESCWA.
(57093)
When using the embedded Rumba display in Eclipse, three new features have been added:
•
•
•

Secure server connections using SSL/TLS.
Multiple TN3270 display views: one view per connection.
Import and export connection details. Additionally, the connection information is now retained
between workspace restarts.

See Running Applications in a TN3270 Mainframe Display in the product documentation for more
details.
•

(9212)
The Format Program option is no longer available for projectless files. Instead, select the Format option
and the text you want to format.
(8743)

Micro Focus Academic Program 7.0 - Release Notes

| 19

•

Customers using Eclipse on Windows who connect to a Development Hub on UNIX can now create
remote unit test projects. Remote unit test projects are available for native COBOL when you use a
Samba or RSE connection to the DevHub.

•

3164533 (13318)
Within a debug configuration for a remote project, you can now specify source files and debug symbol
files that reside on remote hosts other than the one containing the remote project.

•

00363627 (12609)
When starting a server from Server Explorer, if that server is unsecured, you are not prompted to add
any credentials.
(62136)

Enterprise Server
Back to the list
•
•

•

•
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The structure returned by EXEC CICS ADDRESS ACEE now conforms to the IBM IHAACEE definition.
3241109 (11667)
There are more security checks performed in addition to the verification against casout under the
OPERCMDS class. Depending on what options are used, checks are also performed to ensure that the
user has access to a particular job - such as for restarting, modifying, or viewing datasets. The
corresponding rules are under the JESSPOOL class. When trying to retrieve a dataset, additional
checks are made for the particular dataset being accessed. This is also under the JESSPOOL class.
3234588 (11576)
Previously, there was no security check performed when an ESMAC user tries to access the console,
traces, or dumps. This is no longer the case. If you use LDAP-based security you can now add the new
DIAGS resource under OPERCMDS class and provide access to ESMAC users accordingly.
3231918 (12556)
When locks are being stored in a database (for example, when running in a PAC), a CICS ENQ will, by
default, be stored in the region database. ENQs are directed to the cross-region database if they match
an ENQMODEL that has an ENQSCOPE value that is not equal to spaces. This enables ENQs to be
shared outside of the region (or PAC). There is a performance overhead to storing ENQs in the
database. If an application uses ENQs and does not need them to be shared outside of the region, then
you can specify the new attribute in the ENQMODEL resource to direct matching ENQs to shared
memory, this can improve performance. For example, this might be used for an application running in a
PAC that issues multiple STARTs to each ENQ on the same resource. In this case, the STARTed
transactions will all run in the same region and it would be safe to store those ENQs in shared memory
provided that the resource being ENQed on is unique to these STARTed transactions. Note: An EXEC
CICS START that uses the TERMID option might not run in the same region as the STARTing program.
When running in a PAC, the transaction will be transferred to whichever region the terminal is connected
to. In this case, it would NOT be safe for ENQs taken by the STARTed transaction to be stored in shared
memory. You can now specify the _SHAREDMEM option in the ENQMODEL resource to enable
matching ENQs to be stored in shared memory when running in an environment where locks are
normally stored in a database, such as a PAC: _SHAREDMEM(YES | NO) The default value is NO.
Specifying an ENQMODEL with _SHAREDMEM(YES), will store matching CICS ENQs in shared
memory.Caution: This option should only be used if the ENQed resource will not be accessed by any
other region.

•

00367119 (13432)
An abend in the service provider CICS application was not being propagated back to the soap client
when CICS WEB SERVICES were used. This has been fixed.

•

00365431 (13583)
The "Requested Licenses" field has been removed from the ESCWA General Properties page as it is
not used.
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•

(3956)
If CASRDO44_NEWSUB=OFF has been specified in the region's Configuration Information field of the
General Properties page or as an environment variable, then the JES control page will submit only local
jobs, rather than remote jobs.Behaviour Change:When CASRDO44_NEWSUB=OFF is specified in the
region environment, the JES control page will allow for submission of local jobs, rather than remote
jobs.

•

(9431)
Added the option to delete the associated package when the service has an associated package and
that service is the only one with that associated package.

•

00370971 (22264)
When a new region is created in ESCWA, the Web listener's conversation type is now correctly set to
"Web" instead of "SOAP and J2EE (legacy)".

•
•

3244594 (21270)
The Group can now be specified when starting or stopping a region using ESCWA.
00371543 (12436)
For Enterprise Developer 6.0 and later, the installer on Windows has automatically started the
Enterprise Server Common Web Administration (ESCWA) service as part of the installation process.
When using the Japanese system locale on the Windows operating system, the ESCWA service does
not start automatically. During the installation process you might be required to press Retry to complete
a successful product install. Even after a successful product install, ESCWA does not start until you
have installed a valid license.

•

00368527 (12747)
Added StepCC to the Spool DD Display page in ESCWA.

•

3236954 (13587)
The Initial Tran field on the region ES Control page has changed from a list to a text box field.

•

•

•

•

3232139 (11506)
In ESCWA, the Security Manager properties could be set too long, causing a crash. This has now been
fixed.
(61192)
This fixes an issue with the change to the behavior introduced with the passtoken changes in previous
patch updates. An issue might occur in a stacked environment with OS ESM and MLDAP_ESM. Job
dispatch would issue a deny when cassub was used.
3229601 (11524)
An issue when using a secured MFDS, with an LDAP ESM as first in the stack, and a PAM ESM as
second in the stack, and with federation enabled, has been resolved.Previously, if the security was
reinitialized through any means (such as clicking the apply button, or reordering the ESMs and
changing them back), the MLDAP ESM would not be able to correctly determine that the PAM ESM
user user1 in group1 matched the LDAP resource rule which described group1 within the resource rule.
This should have worked because the group information is shared when federation is enabled.With this
fix, the resource rule in LDAP correctly identifies that the group1 rule applies to the PAM ESM user
user1, on both initialization and reinitialization.Behaviour Change:When SAFMGR was reinitialized,
PAM ESM was pointing to the old shared groups table, so MLDAP ESM and PAM ESM ended up
pointing to different shared groups tables. It should have been the same table as federation was
enabled.PAM ESM groups table is now cleared on initialization, so that the ESMs will now point to the
same groups table.
3221760 (11697)
EZA Socket transactions failed under load. To fix this a new version of the CSKL transaction has been
supplied with the product (EZACIC02.cbl).
00422057 (51114)
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•

•

•

ESMAC now includes cross-site request forgery protection. A 403 Forbidden page is now returned
whenever a user attempts to bypass the protection. If you want to access more than one region in
ESMAC at the same time, it can no longer be done in the same browser session. You can access the
regions in separate private browsing sessions.
3216052 (13208)
A new resource class, DCBINFO, enables you to control who can access the DCB information for
cataloged datasets in ESMAC for a LDAP secured region. DCBINFO must be created for existing users
to be able to access the DCB information in ESMAC.
3231918 (13300)
We now take note of VALUE clauses for fields and properties defined in a JVM attribute (annotation),
and output the default value to the class file. When using an attribute, any field that does NOT have a
default value must now be specified explicitly.

•

(30021)
The call format of the first parameter of CEEGTJS has been corrected to be "call by reference" rather
than "call by value".

•

3231324 (12494)
MQ commands did not work because Windows installations of MQ are client, not server. This has been
ccorrected.

•

•

•

(46022)
MFDS now correctly uses the specified region user in the ESCWA Directory Server Scripts page or
Directory Server user in the ESCWA Directory Server Configuration page. Otherwise, it defaults to the
current user.
(8727)
If MFDS is set to "Restricted Access" and the MFDS "Anonymous access" option is off (the default),
then valid authorized credentials will be required to access information stored in the Directory Server
either via the legacy UI, ESCWA, or utilities such as mdump.
(62100)
When MFDS is TLS enabled and a client connects on the non-TLS port, it will now send a HTTP 302
Found response to the client to redirect it from the non-TLS port to the TLS-enabled port. This is
seamless to the Web browser.
(46024)

File Handling
Back to the list
•

The key definitions of newly-created database-hosted files and existing files deployed to a database will
now be honored. Previously, all alternate keys were being created by MFDBFH as "with duplicates"
irrespective of how they were specified in the key definition area of the FCD. This affected files both
created directly by COBOL programs, and those deployed into datastores from disk. One of the side
effects of this problem was that if a catalog and associated SPL*.dat files were extracted from a
datastore, and a CAS JCL region configured to use them, JES failed to initialize during region start-up
due to a file status 3/9 occurring on the SPLJOB.dat file. The dbfhdeploy utility has been enhanced
to allow the keys of existing files to be listed, and to be changed from "with duplicates" to "without
duplicates" if required. It is strongly recommended that if you are using a database-hosted catalog and
associated spool files for an Enterprise Server JES region, that you update the SPLJOB.dat file's
alternate keys by running the following commands:
dbfhdeploy keys 1:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder
dbfhdeploy keys 2:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder
dbfhdeploy keys 3:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder
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dbfhdeploy keys 4:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder
dbfhdeploy keys 5:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder
dbfhdeploy keys 6:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder
See The dbfhdeploy Command Line Utility in the documentation for more details and examples.
•

00372425 (69057)
Within MFDBFH, enhancements have been made to optimized I/O to further improve
performance.Enterprise Developer 6.0 and Enterprise Developer 7.0 only: The dbfhconfig utility has
been enhanced with the addition of the -optiokeyreads and -optioseqreads command-line options.
These options are used to override the default number of records read ahead by MFDBFH when
optimized I/O is enabled.

•

00726932 (83019)
MFJSORT now supports RESTART in SEQNUM processing. The format RESTART=(p,m) is supported.

•

00368449 (13606)
The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

•

3217597 (12477)
A File Handler limit on the maximum record size (62KB) has resulted in the documented limits for datadriven unit tests to be revised. See Restrictions in the Micro Focus Unit Testing Framework.
(25064)

Header-to-COPY Utility
Back to the list
•

When h2cpy is used to convert C header files to COBOL copy files, function prototypes with const *,
which produce BY REFERENCE parameters in the ENTRY statement for the COBOL call prototype, will
now include the CONSTANT reserved word. In this context, it means the variable is read-only in the
callee, just like in C.
(10214)

Interface Mapping Toolkit
Back to the list
•

Headers are no longer mapped in the output of WS2LS.

•

3235120 (12606)
Top-down CWS generation from WSDL now properly marks hexBinary fields in the generated WSBIND.

•

•

3236069 (11690)
WS2LS now assigns usage COMP-3 to items mapped from decimal and integer types in the
WSDL.Behaviour Change:WS2LS will now assign usage COMP-3 to items mapped from decimal and
integer types in the WSDL. This will affect the generated copybooks and WSBIND. Previouslygenerated files will still work, and users should be using the WSBIND and copybooks from a single
execution of WS2LS in their environment anyway, since changing one results in (or reflects) changes to
the other.
3235120 (13494)
In copybooks generated by WS2LS, several data types now have mappings that are closer to those
generated by IBM's DFHWS2LS.Behaviour Change:In copybooks generated by ws2ls, several data
types will now have mappings closer to those generated by IBM's DFHWS2LS.
00365433 (11693)
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JCL Support
Back to the list
•

•

•

00368450 (13425)
The IDCAMS DELETE command has been enhanced to now accept % and * wildcards with the use of
the "MASK" keyword. Because support for multiple wildcards has been enhanced, IDCAMS commands
that previously reported a JCLAM0163S error and set CC to 12 may now be accepted and processed.
00375690 00367509 00368440 (12180)
The support for wildcards when using the IDCAMS LISTCAT command has been improved: both * and
% are accepted within the data set name, and multiple wildcards may be used; for example:
LISTCAT LEVEL(MFI01.MFI%%%%.D*.DAT)

•

00366749 (11515)
When a job contains duplicate step names, you can now specify which step to start.

•

(69229)
You can now restart a JCL job by specifying a value for MF_UCC11.

•

•

•

•
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The IDCAMS DEFINE ALIAS command has been added to enable you to create an ALIAS, or, for a PO
member, the TSO RENAME ALIAS command. When referencing an ALIAS, the related dataset is
resolved. You can also use SYMBOLICRELATE datasets, and the symbol is resolved at run time using
system symbols defined in SYS1.PARMLIB(IEASYM00).

(71227)
A new topic, Advanced Restart Functionality, has been added to the JCL documentation to document
the use of the casout /jrestart option, which enables you to restart a job with additional
parameters. The #t parameter to identifies the step on which to end a restarted job. See your product
documentation for details.
(70223)
A new topic, Advanced Restart Functionality, has been added to the JCL documentation to document
the use of the casout /jrestart option, which enables you to restart a job with additional parameters. The
#k parameter enables you to specify whether or not ABEND and COND codes from a previous run are
used or not. In addition, the #k parameter enables you to specify the COND code to use for a specific
step. See your product documentation for details.
(70224)
By default, a non-zero return code from a commit at the end of a unit of work for DSNAL or IKJEFT**
will now be reported and set a step abend code of S482. You can control this behavior by using the
MF_JES_ABEND_CAF_COMMIT environment variable; see JCL-specific Environment Variables in the
documentation for more details.Behaviour Change:A non-zero return code from the commit issued at
the end of a unit of work, i.e. when the program run as part of the step returns control to the JES
system, will now generate a message in the systsprt and cause the step to abend with the cond code
S482. This behaviour is configurable using the environment variable MF_JES_ABEND_CAF_COMMIT.
A value of ‘NO’ will provide the current behaviour, i.e. we ignore the return code. A numeric value (up to
3 digits) would cause that value to be used as the return code from running the program.
3239642 (11750)
If a MGMTCLAS is defined for a dataset, it will be included in the MGMTCLAS field of the MFJCTLBP
control block.Behaviour Change:The mfjctlbp dataset control block will now include the MGMTCLAS if it
is defined in the catalog record for the dataset

•

3231081 (13361)
A problem that set the wrong parameter override value for a step in a procedure because of the
alphanumeric ordering of the step names was not consistent has been corrected.

•

3235581 (12478)
When changing a GDG roll disposition to EMPTY, the number of rolled-in data sets was incorrect. Now,
if a NONVSAM data set is defined in IDCAMS that is a GDG version, it will be included in the GDG set.
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•

•

3238565 (12731)
A problem that caused the incorrect resolution of output statements in steps with duplicate names has
been corrected. An output statement class of "*" is now replaced by the msgclass of the job.
(30104)
The value of the ALTER NEWNAME will now be checked to ensure it conforms to naming convention
before trying to update the catalog. An error message, JCLAM0105S(12) - Invalid entry name syntax or
length, will be issued if the check fails.Behaviour Change:As per readme

•

3236388 (12641)
When running in a PAC or with the MFDBFH database locking for multiple regions, active jobs are not
flushed at region start-up.Behaviour Change:As per ReadMe

•

3227362 (12487)
It is now possible to include a set of default ON conditions in the VSE configuration file and these will be
added to all VSE jobs.

•

3230967 (11486)
User labels (DLBL & TLBL) are now removed when a new one is assigned following the running of a
program.

•

3213728 (12340)
The system symbols file, SYS1.PARMLIB(IEASYM00), can use the EBCDIC encoding. Support for
EBCDIC programs calling the system symbol entry point, IEFSJSYM, has been added.
3226132 (11503)

Mainframe Access
Back to the list
•

Users will now be able to specify a volume when cataloguing a data set.
(41007)

Micro Focus Batch Scheduler Integration
Back to the list
•

The %%LIBSYM/%%MEMSYM Control-M function variable value is now delimited by the first ending space.
For values that request one or more embedded spaces, use the %%BLANKnn Control-M function.
00422148 (51104)

PL/I Support
Back to the list
•
•

•

•

DEFINE STRUCTURE statements are now supported.
00368478 (12186)
Previously, if STRINGRANGE had been enabled by the -prefix stringrange compiler option, and a user
program did not contain an ON STRINGSIZE statement, there was no message printed out indicating
that STRINGRANGE had been triggered. The message now appears in this scenario.
00696776 (73031)
A performance bottleneck present in Enterprise Developer 5.0 and 6.0 has been resolved to provide
faster record I/O.
00669680 (71440)
Previously, if a job was cancelled while in an active state, PL/I would, as part of RTS cleanup, attempt to
RELEASE all fetched routines. This resulted in a problem because some of the fetchables had the
potential to be active on the callstack and be in a non-cancellable state. This no longer occurs.
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•

•

•

00368471 (27328)
Previously, if using PLISAXA() and XML Element's content contained a character greater than x"7F"
(ASCII), the CONTENT_CHARACTERS event would be driven twice - once for the characters that
preceded the x"7F", and once for the remainder. This no longer occurs and the
CONTENT_CHARACTERS event is driven for the entire XML Element's contents.
00381945 (30084)
Previously, when using PLISAXA, the document length as driven to the Start of Document event was
incorrect if the XML document contained characters that exceeded hex 7F. This has now been fixed.
00381945 (61228)
The diagnostic MPLIE0056 has been changed from a "Severe" level diagnostic to an "Error" level
diagnostic. This provides you with the ability to tailor behavior to your environments. If you wish
compiles to fail in this scenario, you can use the compiler message exit to bump severity back to "S"
level. If you do not wish to have an "Error" level diagnostic in this scenario, you can use the compiler
message exit to reduce severity to "W".Behaviour Change:The diagnostic MPLIE0056, which tells the
customer they have SQLCA declared in an internal procedure, has been changed from a "Severe" level
diagnostic to an "Error" level diagnostic. If the customer desires the old behavior they can bump this
diagnostic to an "S" level diagnostic using the compiler message exit, or if they intend to have the
potential confusion from having multiple SQLCA's declared they can bump the severity down to a
"Warning" level using the same compiler message exit.
3239052 (12538)

REXX Support
Back to the list
•

EXECIO * DISKW was stopping on the first line containing no characters, writing out no further records.
Now after encountering an empty record, a line with only a linefeed is written and processing continues
with the remaining records.
00366667 (27187)

Run-time System
Back to the list
•

•

When defining the file name for CBL_CREATE_STACKDUMP, %f now expands to basename of the
program correctly when used cross-process.
(60049)
When CTF trace level is set to info (for post-offset values only) or debug (for pre-offset, offset and postoffset values) and component rts#process is set to true, the API will now dump the captured metrics to
the output CTF file.
(27040)

SQL: Mainframe Batch Database Tools
Back to the list
•

An equivalent of the mainframe DB2 utility DNSTIAUL, SQLTUL, is now available in the MBDT utility
suite.
2148818 (10857)

SQL: OpenESQL
Back to the list
•
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An issue with compiling native programs that use SQL TYPE IS XML AS CLOB has been resolved.
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3240037 (12679)

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•

The Server Core form of Windows Server 2019 is not supported.

•

Database record locking should not be enabled for Oracle datastores as this may result in COBOL
READ record errors. This means that you should not set the MFDBFH_RECORD_LOCKING=database
environment variable in the environment.

•

In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:
1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.
2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.
In these rare cases, the IS NUMERIC test could provide the wrong answer.
In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL runtimes reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in Visual COBOL 6.0.
Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

•

The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 7.0. This is a result of several tools that are called with a static value=`*` in
the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan attachment
model 5.0 and earlier under Enterprise Developer 7.0 you must remove the static value=`*` from all
CMG_PROP_STATIC_SUBSYSTEM input parameters.

•

Copying and pasting the contents of a license file into the License file field of Micro Focus License
Administration results in the error "The path is not of a legal form. Please contact Micro Focus
SupportLine".

Installation
System Requirements
Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
Visual COBOL and Enterprise Developer for Visual Studio
Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.
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The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

1.2GB

75MB

Enterprise DeveloperEnterprise
Developer

2.3GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Visual COBOL and Enterprise Developer for Eclipse on Windows
The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

3.7GB

75MB

Enterprise Developer

4.5GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.
For a list of the operating systems each individual product in this package supports, check the Product
Availability section on the Micro Focus Customer Care Web site: http://supportline.microfocus.com/
prodavail.aspx.
•

Support for development and deployment on Windows 7, Windows 8 and Windows Server 2012 has
been discontinued. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements
Note: This product includes OpenSSL version 1.1.1k-mf6 (modified).

Windows
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
Visual COBOL and Enterprise Developer for Visual Studio:
You must have Microsoft's Visual Studio 2017 version 15.9.4 or a newer one or 2019 version 16.4 or a
newer one installed in advance.
Note: An issue with Microsoft's Visual Studio 2019 version 16.8 or later affects .NET Core COBOL
projects created with version of Visual COBOL earlier than 6.0 PU4. To avoid the issue, install Visual
COBOL 6.0 Patch Update 4 or later with Visual Studio 2019 version 16.8 or later.
You need one of the advanced versions of Visual Studio listed below:
Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
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Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.
Microsoft's Visual Studio Express Edition is not supported.
Visual COBOL and Enterprise Developer for Eclipse:
The following requirements apply to both Visual COBOL and Enterprise Developer:
•

•
•
•
•

A 64-bit Windows is required. Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit
Windows, the setup file does not install some of the components. See Issues with the Installation in
Known Issues and Restrictions.
The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.16 (2020-06).
The installation requires Java v11 or later such as AdoptOpenJDK 11. If not found on the machine, the
setup file will install AdoptOpenJDK 11 (LTS).
Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.
The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
•

•
•

Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 11 (LTS) with HotSpot, which the Windows product installs automatically.
You can download AdoptOpenJDK's OpenJDK 11 (LTS) with HotSpot from AdoptOpenJDK's Web site
and unpack the archive anywhere on your machine.
Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.
Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL
development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.
By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.
If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:
•
•
•

•
•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
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Downloading the Products
Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:
Windows
1. Run the productname.exe file and follow the wizard instructions to complete the installation.

After Installing
Visual COBOL and Enterprise Developer for Visual Studio
You are now ready to run Visual COBOL or Enterprise Developer. From the Windows taskbar click Start >
All Programs > Micro Focus Product Name > Product Name for Visual Studio. (The Start menu is not
available on Windows 8, Windows 8.1, and Windows Server 2012. You use the Start screen to invoke
programs.) By default, the Help is available online on the Micro Focus SupportLine Web site: https://
www.microfocus.com/support-and-services/documentation/.
To see the Help:
•
•

Click Help > Micro Focus Product Help > Product Documentation.
Alternatively, press F1 inside the editor or from a UI part.
This opens the Visual COBOL help or Microsoft's MSDN depending on which keyword in the editor or
part of the UI you are querying.
Note: Your Visual Studio might be configured to show the local help. To switch to online help, click
Help > Set Help Preferences > Launch in Browser inside Visual Studio.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.
Visual COBOL and Enterprise Developer for Eclipse
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
2.
3.
4.
5.
6.
7.

You may receive some warnings or errors which you can ignore.
Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.
From the Open Perspective dialog box, click the perspective you want to reset.
Click OK.
Click Window > Perspective > Reset Perspective.
When prompted, click Yes.
Reapply any customizations.

To view the help:
•
•

Click Help > Micro Focus > Product Documentation.
Alternatively, press F1 inside the editor or from a UI part.
This opens a browser with the Visual COBOL help.
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Note: By default, Eclipse is configured to show the local help. See the installation notes within the
product Help, for instructions about how to switch to local help.
Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Repairing
Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.
If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.
Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.
Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
Some registry entries are not removed by the uninstallation process and you need to manually delete
them.
The following folders might not be removed:
•
•

Micro Focus Product Name folder in the Start menu - you can delete it manually.
%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
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•
•

%ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
%Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer
©

Copyright 2021 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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